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1. Was ist Lotus Notes und was sind dessen Funktionen? 
 
Das Softwarepaket Lotus Notes/Domino der Firma IBM ist eine sogenannte Groupware 
Plattform. Vereinfacht gesagt bezeichnet der Begriff Groupware eine Software, die 
Personengruppen bei ihrer täglichen Zusammenarbeit unterstützt. Eine Groupware Plattform ist 
eine sogenannte Middleware, auf deren Basis höherwertige Groupware Applikationen, die 
spezielle Geschäftsprozesse unterstützen, entwickelt werden können. Bei der Lotus 
Notes/Domino Plattform handelt es sich um eine Client Server Architektur. Der Lotus Domino 
Server stellt bestimmte Dienste bereit, die von verschiedenen Clients genutzt werden. Mögliche 
Clients sind z. B. ein Web-Browser oder der auf Groupware Applikationen spezialisierte Lotus 
Notes Client. Zur Vereinfachung wird die Plattform im Folgenden mit „Notes“ bezeichnet. 
 
Die wichtigsten Funktionen von Notes sind: 
• Unterstützung von Kommunikation, Kollaboration und Koordination 
• Asynchrone Kommunikation: z. B. Senden und Empfangen von eMails 
• Synchrone Kommunikation durch Lotus Sametime Integration: z. B. Chat, Video 

Conferencing, Application Sharing 
• Informations-, Dokumenten- und Knowledge-Management (KM): Verwaltung multimedialer 

Informationen in Dokumenten und Verwaltung dieser Dokumente in gemeinsam genutzten 
Datenbanken, sowie Rückgewinnung dieser Informationen (über Suchfunktionen, Ansichten- 
und Ordner-Konzepte, multidimensionale Kategorisierung) 

• Automatisierung von Prozessen (Agenten) 
• Strukturierung, Steuerung und Verfolgung von Geschäfts-Prozessen (Workflow 

Management) 
• Räumlich und zeitlich verteiltes Arbeiten (Mobile Computing, Teleworking) an sog. 

Repliken von Originaldatenbanken (synchronisierbare Kopien), die bidirektional 
abgeglichen werden können (Replikation) 

• Integrierte Anwendungsentwicklungsumgebung 
• Zugang zum Internet, Möglichkeit, Informationen im WWW zu veröffentlichen und Zugriff 

auf Notes-Datenbanken vom Internet über einen Internet-Browser 
• Differenzierte Sicherheitsmechanismen zum Schutz von Informationen vor Fremdzugriff 
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2. Grundlegende Informationen zur Notes-Architektur 
 
Notes speichert Informationen in sogenannten Datenbanken. Jede Datenbank enthält 
Informationen über ein besonderes Thema, zum Beispiel Adressen oder Produktinformationen. 
Die Person, die die Datenbank erstellt, bestimmt zugleich den Typ von Informationen, die in 
der Datenbank abgelegt werden sollen. Aus Datenbanken können zu jeder Zeit aktuelle 
Berichte, zum Beispiel Anwesenheitslisten oder Spesenabrechnungen, erstellt werden.  
 
Eine Datenbank enthält in der Regel eine Vielzahl von Dokumenten. Dokumente speichern 
Informationen in einer vorgegebenen Datenstruktur. Da Notes-Datenbanken alle Informationen 
in Dokumenten ablegen, werden sie auch als Dokumenten-Datenbank bezeichnet. Dokumente 
mit gleicher Struktur bilden einen sogenannten Dokumenttyp. In einer Datenbank kann es 
beliebig viele unterschiedliche Dokumenttypen geben. In einer Diskussionsdatenbank können 
beispielsweise Dokumente des Typs Thema und des Typs Beitrag enthalten sein. Die Struktur 
des Typs Beitrag ist dabei darauf angelegt, dass das Dokument einen Kommentar zu einem 
Dokument des Typs Beitrag darstellt.  
Die Struktur eines Dokumenttyps wird durch eine Maske festgelegt, welche ebenfalls in der 
Datenbank enthalten ist. Masken enthalten Felder, die mit den entsprechenden Informationen 
ausgefüllt werden können und dienen der Erstellung und Bearbeitung von Dokumenten. 
Masken können auch Verarbeitungslogik enthalten, die das Erstellen und Arbeiten mit 
Dokumenten erleichtern. 
Befindet sich eine Datenbank auf einem Domino Server, können viele Personen gleichzeitig auf 
die Datenbank zugreifen und so gemeinsam mit den Dokumenten arbeiten. Notes verfügt dabei 
über umfangreiche Sicherheitsmechanismen, die es erlauben, sämtliche Zugriffsrechte auf 
Datenbanken und Dokumente genau zu regeln. So ist es möglich, dass in einigen Datenbanken 
bestimmte Personen Dokumente zwar lesen, aber nicht ändern können, in anderen Datenbanken 
wiederum jeder Benutzer eigene Dokumente erstellen kann.  
 
Sollen also Informationen zu einer Datenbank hinzugefügt werden, wird die entsprechende 
Maske ausgefüllt und das fertige Dokument in der Datenbank gespeichert. Benutzer mit der 
entsprechenden Zugriffsberechtigung können die erstellten Dokumenten lesen und evtl. 
Bearbeiten, sowie weitere Dokumente erstellen. 
 
“Genial einfach, aber was, wenn es Hunderte von Dokumenten gibt?” 
 
In papierorientierten Büroumgebungen existieren häufig so viele Dokumente, daß es schwierig 
wird, die gewünschten Informationen zu finden, da sie in der Regel nur nach einem Kriterium 
sortiert sind, z. B. nach Aktenzeichen, Datum oder Kundenname. 
Notes bietet zur Lösung dieses Problems im Bereich von elektronischen Dokumenten viele 
verschiedene Möglichkeiten zur Anzeige und Sortierung von Dokumenten. In einer Ansicht 
werden Dokumente einer Datenbank in einer bestimmten Sortierung (z. B. nach Namen) oder 
nur in Teilmengen angezeigt. 
In einer Datenbank beispielsweise, die eine Firma benutzt, um Personalinformationen zu 
speichern, gibt es ein Dokument für jeden Beschäftigten. Die Datenbank könnte die folgenden 
Ansichten enthalten: 
 
• Eine Ansicht, die alle Beschäftigten nach Namen sortiert anzeigt. 



• Eine Ansicht, die alle Beschäftigten nach Vornamen sortiert anzeigt. 
• Eine Ansicht, die alle Beschäftigten nach Abteilung sortiert anzeigt. 
• Eine Ansicht, die die Beschäftigten zeigt, die einen Parkplatz in der Tiefgarage haben. 
• Eine Ansicht der Beschäftigten, die innerhalb des letzten Jahres eingestellt wurden. 
 
Zu beachten ist, dass die ersten drei Ansichten die Dokumente aller Beschäftigten enthalten, die 
letzten beiden dagegen nur einen Teil davon. 
 
Man kann auch Ordner in einer Datenbank erstellen. Während die in Ansichten gezeigten 
Dokumente automatisch ausgewählt werden, können Dokumente in Ordnern manuell abgelegt 
werden, um sie später leichter zu finden. Das bedeutet, dass der Benutzer selbst auswählen 
kann, welche Dokumente in diesen Ordnern erscheinen sollen. In der Personaldatenbank zum 
Beispiel könnte ein Ordner erstellt werden, der nur die häufig benutzten Dokumente enthält 
oder nur Dokumente, die durch die Abteilungsleitung als besonders wichtig empfunden werden. 
Ein Dokument kann sich in mehreren Ordnern befinden, genauso wie es in mehreren Ansichten 
angezeigt werden kann. 
Masken, Ordner und Ansichten sind sogenannte Gestaltungselemente. Gestaltungselemente 
bestimmen die Funktionalität einer Datenbank. Zur Änderung von Gestaltungselementen sind 
entsprechende Rechte auf der Datenbank, sowie ein Domino Designer Client notwendig. 
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3. Die Lotus-Notes-Installation 
 

 
1. Die Datei Setup.exe im Verzeichnis AllClients der Notes-CD wird gestartet: 

 
 Weiter mit Next. 
 
2. Die Lizenzbedingungen annehmen und mit Next bestätigen. 
 
3. In das Feld „User Name“ den vollständigen Namen eintragen. 

 
4. Im Feld „Organization“ bitte den vollständigen Firmennamen eintragen 

(Wirtschaftsinformatik 2, Universität Paderborn). Weiter mit Next. 
 
5. Im nächsten Fenster werden die Installationsverzeichnisse vorgeschlagen, es kann mit dem 

„Change…“-Button jeweils ein anderer Programm- und Datenordner angegeben werden. 
Der Programmordner enthält die Dateien, die zu Ausführung von Lotus Notes notwendig 
sind. Der Datenordner enthält die Datenbanken, in denen Dokumente gespeichert werden. 
Weiter mit Next. 
 



 
 
6. Nun sind die Installationsoptionen zu wählen. Standardmäßig ist nur der „Notes Client“ 

ausgewählt. Sollen weitere Komponenten installiert werden, kann mit einem Mausklick auf 
den Kasten vor dem entsprechenden Eintrag eine Installationsoption gewählt werden (siehe 
Screenshot). 
Der Domino Designer ist notwendig, um die Gestaltungselemente von Datenbanken zu 
ändern. Der Domino Administrator ist notwendig, um einen Domino Server zu 
administrieren. 
Weiter mit Next. 

 
 
7. Die Installation wird nun mit „Install“ gestartet und benötigt ca. 280 MB 

Festplattenspeicher. 
 

8. Jetzt beginnt der Installationsprozess. 
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4. Das Notes-Setup für Studierende 
 
 
Bevor Notes zum ersten Mal ausgeführt wird, muss an Computern, die über einen Zugang zum 
Internet verfügen, eine TCP/IP-Verbindung zum Internet hergestellt werden.  
Dieses Vorgehen ist von der Art des Internetzugangs abhängig (Modem, ISDN, DSL). Im 
Prinzip sollte aber so vorgegangen werden, als ob man "ganz normal" im Internet surfen oder 
seine eMails abrufen möchte. 
 
Ist eine Verbindung hergestellt, kann das Programm mit der entsprechenden Verknüpfung  
(standardmäßig in der Gruppe Lotus Applications) gestartet werden: 
 
1. Weiter mit Next. 
 
2. Namen und den Domino Server eintragen.  

Der Domino-Servername ist: PBWI2B/WI2/FB5/UniPB/DE  
 

3. Hier standardgemäß „I want to connect to a Domino server“ auswählen.  
 
 
 

 
Weiter mit Next. 
 
4. Nun sind folgende Einstellungen zu machen. 



 
 
5. Nun muss die Notes-ID ausgewählt werden, die Sie in Form einer ID-Diskette von der 

Fakultät für Wirtschaftswissenschaften erhalten, oder von der entsprechenden Website 
herunter geladen haben. 
Legen Sie nun die Diskette ein, und wählen Sie mit dem „Browse“-Button den Pfad des 
Diskettenlaufwerks aus. Optional wählen Sie die ID Datei aus, die Sie von der Website 
herunter geladen haben. 
 

 
6. Die User-ID, bestehend aus dem ersten Buchstaben des Vornamens und den ersten sieben 

Buchstaben des Nachnamens, auswählen. Weiter mit Öffnen. 



 
7. Im nächsten Fenster wird abgefragt, ob die ID auf die Festplatte kopiert werden soll. Diese 

Frage sollte mit Ja beantwortet werden, da ansonsten bei jedem Start von Lotus Notes die 
Diskette mit der Notes-ID eingelegt werden muss. 

 
8. Das Passwort eingeben. Sie finden das Passwort der ID Datei in dem Briefumschlag, der 

Ihnen durch den Mitarbeiter der Fakultät ausgehändigt worden ist. In dem Umschlag 
befindet sich ein Zettel, auf dem das individuelle Notes-Passwort und das damit identische 
Internet-HTTP-Passwort angegeben sind. 

 
9. Als nächstes sind Angaben zum Instant Messaging zu machen. Dazu bitte die Maske wie 

folgt ausfüllen: 
 

 
 
 



 
 
10. Finish auswählen. Damit ist das Setup beendet und Lotus Notes wird gestartet. 
11. Beim starten von Lotus Notes müssen nun zwei Passwörter eingegeben werden. Zunächst 

das Notes Passwort und danach das HTTP-Passwort für den Zugang zum Instant 
Messaging  

 

 
 

 
 

 
Es wird empfohlen, die Einstellungen die das Setup vorgenommen hat, entsprechend dem 
Abschnitt Trouble Shooting zu überprüfen. 
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5. Wie kann ich mein Lotus-Notes-Passwort ändern? 
 
 
1. Notes starten. 
 
2. Den Menüpunkt „File -> Security -> User Security“ auswählen. 

 
3. Das alte Passwort eingeben. 

 
4. Auf die Schaltfläche „Change Password” klicken. 

 
5. Das alte Passwort eingeben. 

 
6. Das neue Passwort eingeben. 

 
7. Das neue Passwort zur Kontrolle erneut eingeben. 

 
8. Mit OK bestätigen. 

 
Damit ist das Passwort der ID-Datei, die während des Setup-Prozesses in das 
Datenverzeichnis kopiert wurde, geändert. 
Das Passwort auf der Originaldiskette entspricht weiterhin dem Passwort auf dem Zettel, es 
kann auf der Diskette nicht geändert werden. Daher muss die ID-Diskette sicher 
verwahrt und vor Zugriffen Dritter geschützt werden. 

 
Wichtig: 
Das Internet-Passwort lässt sich auf diese Weise nicht ändern, sondern bleibt unverändert  
(siehe Punkt 6). 
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6. Wie kann ich mein Internet-Passwort ändern/löschen? 
 
 

1. Notes starten. 
 
2. Das Mailfile öffnen und mit dem Button „New Memo“ eine neue Mail erstellen. 

 
3. Im Feld „To“ muss „HTTP-Password“ eingetragen werden. 

 
4. Der Eintrag „Set Password“ im Feld „Subject“ setzt ein neues Internet-Passwort 

beziehungsweise überschreibt ein schon vorhandenes.  
„Remove Password“ im Feld „Subject“ löscht das bestehende Passwort. 

 
5. Im Body der Mail darf ausschließlich das gewünschte Passwort stehen. 

Es muss mindestens 12 Zeichen umfassen und zwei Sonderzeichen (!,#,$ …) oder 
Ziffern enthalten. 
 

6. Über den Button  gelangt man in das folgende Fenster: 

 
 
7. Hier muss die Verschlüsselung und die Signierung der Mail aktiviert werden  

(siehe Screenshot). 
 

8. Die Änderung wird umgehend durchgeführt und sollte nach ca. 5-10 Minuten aktiv sein. 
Nach erfolgreicher Änderung des Passwortes erfolgt eine Bestätigung per Mail. 

 
9. Dieser Mechanismus ist ausschließlich für Studierende ("Name/Student/UniPB/DE") 

vorgesehen. Die Verfahrensweise für alle anderen Lotus Notes NutzerInnen ist auf 
Anfrage bei Ulrich Förster zu erfahren.  
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7. Wie kann ich auf mein Mailfile zugreifen? 
 

 
Es gibt zwei Möglichkeiten, mit Lotus Notes auf Datenbanken des Servers zuzugreifen.  
Die erste Möglichkeit ist, dass man direkt und online auf die Datenbanken auf dem Server 
zugreift. Für diese Methode ist eine schnelle Internet-Verbindung (z. B. DSL) und eine 
zeitunabhängige Kostenabrechnung der Online-Zeiten (Flatrate) zu empfehlen, da man immer 
so lange online sein muss, wie man auf den Datenbanken arbeitet. 
Die zweite Möglichkeit ist, dass auf dem lokalen Computer eine sogenannte Replik der zu 
bearbeitenden Datenbank (zum Beispiel des Mailfiles) erstellt wird. Eine Replik ist eine 
synchronisierbare Kopie der serverbasierten Datenbank. Es kann nun offline mit der Datenbank 
gearbeitet werden (zum Beispiel zum verfassen und lesen von Mail-Dokumenten). Änderungen 
der lokalen Datenbank werden in einem Replikationsprozess mit dem Server synchronisiert, so 
dass die Datenbank auf dem lokalen Rechner vor Ort und die Datenbank auf dem Server wieder 
denselben Bearbeitungsstand aufweisen. Bei diesem Vorgehen muss der Benutzer nur während 
des Replikationsprozesses mit dem Server verbunden sein.  
  
Folgende Schritte sind nötig, um eine solche lokale Replik zu erstellen: 
1. Eine Internet-Verbindung herstellen 
2. Notes starten 
3. Passwort eingeben  
4. Nun mit einem Rechts-Klick auf das Mail-File und den Menü-Punkten „Replication -> 

New Replica..“ klicken. 

 
5. Im Feld "Server" den „lokal“-Server eintragen und mit Ok bestätigen. 
6. Mit dem „Replicator“ kann nun diese Replik mit dem Server abgeglichen werden. 
7. Wird der Replikationsprozess zum ersten Mal durchgeführt, so kann dieser Prozess einige 

Minuten in Anspruch nehmen. 
8. Nun muss im Location-Dokument eingestellt werden, dass sich das Mailfile auf dem 

lokalen Rechner befindet (siehe Abschnitt Trouble Shooting).  
9. Danach kann die Mail-Datenbank auch lokal durch einen Doppelklick auf die Kachel 

geöffnet werden. 
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8. Trouble Shooting 
 

 
Die meisten Fehlermeldungen, die beim ersten Umgang mit Notes entstehen, sind auf fehlende 
beziehungsweise fehlerhafte Einstellungen im Connection- oder Location-Dokument 
zurückzuführen. 
 
 
Das Connection-Dokument: 
 
1. Das Adressbuch öffnen: 
 

 
2. Mit den Menüpunkten „View-> Advanced -> Connections“ in die entsprechende Ansicht 

wechseln: 

 
 
3. Sollte die hier markierte Connection nicht existieren, so muss sie mit „Add Connection“ 

neu erstellt werden. 
Zur Überprüfung der Einstellungen eines schon vorhandenen Connection-Dokuments wird 
auf diesen Eintrag doppelt geklickt. Mit einem Klick auf „Edit Connection“ wird in den 
Editier-Modus des Dokumentes gewechselt. Folgende Einträge sind zu erstellen: 



 
4. Im Register „Basics“:  

• Connection Type „Lokal Area Network“ 
• Use LAN port: TCPIP aktivieren 
• Server name: "PBWI2B/WI2/FB5/UniPB/DE“ 

 
5. Im Register „Comments“ brauchen keine Änderungen vorgenommen werden. 
 
6. Im Register „Advanced“ muss im Feld „Destination server adress“  
 „PBWI2B.Uni-Paderborn.de“ eingetragen sein. 
 
7. Mit „Save and Close“ das Dokument speichern. Nach einem Neustart von Notes sind die 

Änderungen wirksam. 
 
 
 
Das Location-Dokument: 

 
1. Wichtig: Die hier beschriebenen Einstellungen beziehen sich auf die Situation, dass eine 

lokale Replik des Mailfiles erstellt wurde (siehe Punkt 6).  
 
2. Das aktuelle Location-Dokument ist über einen Button am rechten unteren Rand des Notes-

Fensters zu erreichen. Dieser Button ist mit dem Namen der aktuellen Location beschriftet. 
Nach einem Klick darauf öffnet sich folgendes Menü: 

 
3. Hier wird der Punkt „Edit Current...“ ausgewählt. 

 
 
4. Im Register „Basics“ ist wichtig, dass als Location-Typ „Lokal Area Network“ eingestellt 

ist. 
 
5. Das Register „Servers“:  



 
 
6. Im Register „Ports“ ist nur TCPIP zu aktivieren. 
 
7. Das Register „Mail“: 

 
 
Im Feld „Mail file“ muss der Pfad des Mailfiles ab dem „Notes\Data“-Pfad angegeben 
werden. Die Benennung dieser Datenbank setzt sich aus dem ersten Buchstaben des Vornamens 
und den ersten sieben Buchstaben des Nachnamens plus der Erweiterung „.NSF“ zusammen. 
Befindet sich das Mailfile zum Beipiel im Verzeichnis „C:\Lotus\Notes\Data\“, so muss in 
dem Feld nur der Dateiname der Datenbank angegeben werden (Standardfall). 
Mit „Save and Close“ werden die Änderungen gespeichert. Nach einem Neustart von Notes 
sind die Änderungen wirksam. 
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9. Zertifikat verlängern 
 
1. Jede Notes-ID enthält ein Zertifikat, das zur Nutzung des Servers berechtigt. Dieses 

Zertifikat hat eine zeitlich beschränkte Gültigkeit. Wenige Monate bevor das Zertifikat 
abläuft, wird mit einer Hinweisbox beim Start von Notes darauf hingewiesen.  
 

2. Das Zertifikat kann nur so lange per eMail verlängert werden, wie es noch nicht abgelaufen 
ist: 

 
3. Über die Menüoptionen „File -> Security -> User Security“ 
 
4. Benutzerkennwort eingeben. 

 
 

5. Auf „Renew“ klicken und die Adresse WI2Manager bestätigen. 
 

 
 

Ist das Zertifikat bereits abgelaufen und nicht mehr in der oben beschriebenen Weise 
verlängerbar: 
 
1. Das Passwort auf der ID-Diskette auf das Standard-Passwort „NotesNotes“ (siehe Punkt 5) 

ändern. 
 



2. Diese Diskette zu den bekannten Öffnungszeiten (siehe http://gcc.upb.de) im Raum E5.318 
abgeben. 
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